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Typing Math: Symbols and Graphing 
 
The purpose of this assignment is to learn how to produce word-processed documents containing mathematical 
expressions and graphs that look like they could have come from a textbook. The introductory information is to 
show the difference between how math expressions look when typed by an amateur and when typed by a 
connoisseur of the mathematical typewritten word. In the next section, you’ll find brief instructions on how to use 
MathType 6 to produce professional-quality results. Unfortunately, it’s apparently no longer possible for me to 
install that on the school laptop cart, so if you’re using a school computer, the second section will show you how to 
use the equation editor built in to Microsoft Word in class. It works okay, and it’s free for you, too. The next 
section is a primer on producing good graphs with GeoGebra. Finally, you will find an assignment to complete 
using those skills. 
 

Introduction: How “good math” looks on the page. 
In the table below you will find examples of incorrectly and correctly typeset mathematical expressions. 

Incorrect	 Correct*	 Comments 	
*In each case, the second example uses the Microsoft equation editor. 

y = -(x-2)^4 + 1 ; 
𝑦 = (𝑥 − 2)) + 1 

Three things here. The obvious one is that the exponent should be typed as a 
superscript rather than with a caret (^). The other two are more subtle. 
Variables are italicized, in general, as are the names of points and constants 
like e (in the U. S., anyway). Finally, a minus sign (or negative sign, 
depending on the context) is not just a hyphen, it’s an en dash, which is 
longer. Important: Both MathType and Microsoft’s equation editor take care 
of the italics and the longer minus sign for you. You just type in an equation 
field, and it handles that formatting. If you choose to type the names of 
variables in a sentence, though, you have to italicize them yourself.	

√(sin x)/(1+x2) ; √-./ 0
1203

	

The second one is beautiful by comparison, don’t you think? The equation 
editors handle the fraction, the radical, and the italics all at once. (And 
slanted fractions are evil.) Also, I really do prefer the look of MathType. You 
can get the version I used to create those expressions for free. I will help you 
with that if you want to use it.	

f(|-x|2)= f(|x2|) ; 
𝑓(|−𝑥|6) = 𝑓(|𝑥6|)	

Notice here how MathType lets me have parentheses and vertical bars that 
grow with the expression inside. Microsoft does, too, but the choices it makes 
here are not so obviously larger. You don’t get the expanding versions by just 
typing parentheses and vertical bars. You choose them from menus (or with 
keyboard commands). Also, notice that function names are italicized, but 
parentheses and numbers are not. Equation editors do that automatically; if 
you were typing “regular” text in a word processor, you would have to do it 
yourself.	

   {x, if x >=0 
|x| = {-x, if x < 0	

; 

|𝑥| = 7 𝑥, 𝑥 ≥ 0
−𝑥, 𝑥 < 0	

The first is a noble but ill-fated attempt to type the definition of absolute 
value as a piecewise function. The second is how it ought to look. It uses a 
2´2 grid to organize the parts of the piecewise function; this is found in the 

 or  menu. The correct version also has a left brace that will grow 
to whatever height is needed, automatically, from the  or  menu. 
By the way, while ≥ can be found in a menu, > and < are just keys on the 
keyboard.	

y2 = 4 => y = +/-2 y2 = 4 ⇒ y = ±2; 
𝑦6 = 4 ⟹ 𝑦 = ±2 

The implication arrow and the plus-or-minus sign are in menus. In general, 
you will have a much simpler time doing this if you type regular words as 
text in your word processor, and then choose Insert Equation whenever you 
need a mathematical expression. In particular, keeping MathType open and 
copying and pasting from there seems to cause crashing problems. 	

2.3 x 10-5 2.3 ´ 10–5; 
2.3 × 10BC 

The ´ sign is in a menu. Use of x italicized for multiplication not only looks 
funny, it’s just plain wrong.	

h(x) = 2x2/(x2 – 9) 	
This one wasn’t completely wrong to begin with, just not easy to read. Avoid 
the use of slanted fractions, especially when there is more than one term in 
either the numerator or denominator. They require very careful use of 
parentheses, and even then can be hard to follow.	

lim [(sin x)/x] 
x->0	 ; lim

0→H

-./ 0
0
	

MathType’s command to put the x ® 0 part right under the limit is in the 
 menu. Microsoft’s is in the menu that says limit.  
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MathType: Using the program 
MathType was sold to another company, Wiris, in 2017. Unfortunately, MathType 7, the new version, is 
actually a renamed version of Wiris’s previous product — not at all the same. Even more unfortunately, the 
new program does not have a forever-free version; they only operate on an annual subscription. With the old 
version, if you install the demo version and, after 30 days, you don’t pay for it, it reverts to a program called 
MathType Lite, which is what I originally used to type this document. Clearly, the Lite version will do 
everything you need, and it’s free. As I type this, older versions are still available at	
https://store.wiris.com/en/products/downloads/mathtype/v6 . You download the installer for your platform 
(Windows or Mac) at the top of the appropriate column. If this link goes away, I still have the installers for 
MathType 6.9 for Windows and MathType 6.7 for Mac, the last ones produced before the switch. 
 
When you first install MathType and have Microsoft Word on your Windows computer, you automatically get 
a MathType tab, and the very first choice there, “Inline,” is the one you want. (Unfortunately, Word 2016 for 
Macintosh does not work well with MathType, but Pages and Word 2011 should. I strongly recommend 
Pages.) If you’re using some other word processor, I can’t promise the automatic button, but after you’ve 
installed the program, you can go to the Insert menu or tab and choose Object, then MathType equation. While 
you are students in the Polk County Schools, you have access to Office 365 and can install Microsoft Office 
on your own computer. Start at https://polkschoolsfl.com and click on Office 365 on the left side of the 
Students drop-down. MathType 6 does not work with the online versions of Word. 
 
When you insert an equation, you’re presented with a window more or less like this. (You may have more 
rows of things during the first 30 days.) I am aware that the date of this screen shot is old; that has to do with 
my current use of a Mac. 

 
 
You type in the large middle area. The buttons at the top are all drop-down menus of various symbols (on the 
top) and templates (on the second row). The names don’t matter so much, but the difference is that the boxes 
on the second row provide places for you to input more expressions. The symbols on the buttons give you 
some idea of the types of things you will find in the menu. In general, when you need one of the things on the 
second row, like a fraction or a vector, you should choose the template first, then type the numbers or letters. 
In the full version, some commonly used things are more readily accessible, and you can click on those, too. 
At the end of the MathType section of this document, you will find a set of screen shots of those menus that 
may help you find things more easily at first. 
 
For the most part, the program works exactly like you would expect it to. For instance, if you choose a fraction 
template from the second row, you first type in the numerator, then either click in or tab to the denominator. 
The tab key will move you through the various parts of an expression easily. To update the equation in your 
document and close the window all at once, use Control-F4 (Windows) or ⌘-W (Mac). 
 
A couple of things to know: Sometimes, the program will treat an expression like a variable when you know it 
shouldn’t. For instance, entering this integral normally gives . (Don’t worry now about what it 
means. What you need to know is that the part after the squiggly sign should look like “arccsc x dx” — with 

cscarc xdxò
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no italics on the first part, and a space between x and dx. To fix that, select the “arccsc” part, and choose 
Function from the Style menu. That will remove the automatic italics. You can insert a space not, as you 
would expect, by just typing the space key (fooled you!), but choosing a space  
 

in the menu. If you just try a space in Math style, the program will beep at you, indicating 
 

that it thinks it’s smarter than you are in matters of mathematical typesetting. And to be fair, that’s generally 
true. Here’s how the integral should look: . 
 
Secondly, there’s another oddity about integrals (a calculus thing, for those of you who still haven’t figured 
out when you’re going to run into them). Compare these two expressions: 

 and . 

See how the second one looks better? MathType doesn’t automatically use an expanding integral sign, while 
parentheses, brackets, and so on, all adjust size automatically. To get the second one, hold down the Shift key 
while clicking on the menu and selecting the integral (the one with little black rectangles where you see the 
numbers in mine). That makes it adjust to fit what you type. 
 
MathType’s symbol and template menus, with some comments: 

 Note that ! and " 
are not > and <. The 
latter pair is on the 
keyboard. Of the 
computer. On the 
comma and period 
keys.	

For changing spacing 
and making dots. 	

 Some of the things 
on this menu are not 
available in Lite 
mode. You can tell 
when the cursor 
changes as you 
hover over them. I 
never use those.	

 This is where the 
multiplication 
symbols are found. 
For a multiplication 
dot, you want the 
smallest one. The 

open circle you see here is not the 
degree sign. That’s a few menus 
down.	

 This is where 
to find the 
implication 
arrow (⇒) and 
function 
mapping 
symbol (↦).	

Logical 
operators 
and set 
symbols.	

This is the menu 
with the degree 
sign, doublestruck 
set names, and the 
angle symbol 
from geometry.	

Lowercase pi (p), 
theta (q), alpha (a), 
beta (b), phi (f), 
sigma (s), and 
omega (w) are all 
here.	

Upper case Greek 
letters. The ∆ 
(delta) is also useful 
as a triangle 
symbol.	
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This is where 
you’ll find 
parentheses, 
brackets, and 
absolute value 
signs that expand 
to hold what you 
type, as well as 
one-sided versions 
of those.	

The first one is a regular 
fraction and the second 
is a smaller fraction. 
Remember that slanted 
fractions are evil, and 
don’t use them. Also, 
you have the square root 

sign as well as a template that lets 
you put in a different index to tell 
which root.	

The very first one is 
for superscripts. The 
one that you want 
for the limit I typed 
in my examples is in 
the middle of the 
third row. The ones 
with bigger boxes 

make the text in them bigger, too.	

These are 
summations. The 
little black boxes are 
places you can type 

additional small text.	

Remember that to get 
one of the integral 
(curvy S) signs that 
expands with what 
you type, you have to 
hold down the shift 
key while selecting 
from this menu.	

The lowered bar 
on a single 
character (see 
#16) is in the first 
row, not here. 
These are used to 
put more than one 
character in a box.	

The arrows here look 
like they belong in 
ChemistryType, not 
MathType.	

These are good for 
matrices, but equally 
excellent for aligning 
things evenly, as in 
the absolute value 
(piecewise function) 
example at the 

beginning.	

These make borders on 
various sides; they 
could be used to make 
things like times-tables. 

Some of the most commonly used things have easy-to-use keyboard shortcuts. The ones I use the most are 
Ctrl-F for a fraction, Ctrl-R for a radical, and Ctrl-H for superscript (up High) — note that on a Mac, this last 
one is ⌘E for exponent (as the system command ⌘H hides the current program).  
 
If you’re interested in investigating what some of these symbols mean, a good place to start would be 
http://en.wikipedia.org/wiki/List_of_mathematical_symbols. 
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Microsoft’s Equation Editor: Perfectly adequate, and built-in 
 
I’ve already indicated that this is not my favorite tool, but I’ve spent far too long looking into alternatives that 
never seem to be the right thing. I’m willing to concede, for now, that many of you are going to need to use it. 
 
The screen shots in this section are from a Mac, but I think you’ll find that the Windows version is similar 
enough that you’ll be able to follow on a school laptop. To insert a new expression, go to the Insert tab. On the 
right end, the Equation icon is both a button to click (easiest) and a drop-down menu to choose some 
expressions that someone thought were going to get a lot of use. Just click the big  button. You will be 

presented with an Equation editor object like this: . You will also see that the Equation 
tab appears and is active. That looks like this: 

 
You can find not only the symbols immediately visible on the left, but also a few more screens of those by 
either scrolling to the right with the > or hovering above the characters and clicking on the ⌄ to get a scrolling 
list. 
 
Microsoft’s Equation Editor symbol and template menus, with some comments: 

Most of the symbols you are likely to need 
will be in these first two screens. The 
capital delta (Δ) and the symbols for 
various sets are a little farther along. 
 

The first fraction 
template is going to be 
the best one in almost 
every circumstance. 
Don’t use slanted 
fractions when you’re 
typing math. It looks 
unprofessional. 

When you select these, 
you get boxes to type in. 
I find it annoying that 
the cursor never seems 
to end up where I want 
it. You can use the 
arrow keys on the 
keyboard to select the 

correct box to type in. 

I cannot explain the 
presence of a radical 
with an index of 2. Who 
does that? 

This is where I stop 
showing everything in the 
template menus. You’re 
not going to need 
anything beyond the first 
row for this course. 

Similarly here, only 
the first row is likely 
to be useful to you in 
high school.  

I don’t think it would ever 
occur to me to use any of 
these. I would just type. If 
you type a space after “sin” 

(for instance), the program recognizes that as a 
function name and removes the italics. 
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The parentheses and vertical 
bars in the first section will get 
larger to hold contents with 
fractions and superscripts. The 
“single brackets” section is 

where you find the one-sided { for piecewise functions. 

The overbar in the third 
row is useful. 

The limit symbol is here. 

You	can	find	arrows	to	
go	over	vectors	and	lines	
in	this	menu.	

This	is	how	I	spaced	the	
contents	of	the	definition	
of	absolute	value	on	the	
first	page.	

 
There are some quirks. When you want an expression to appear “inline,” which is to say in a sentence of text 
or next to a problem number, you need to have some text on the line first. If you don’t, Microsoft will make 
the equation a display version, which is centered on the page. It’s possible to change that after the fact, but it’s 
easier to make sure there’s already some text on the line. 
 
I have not spent a lot of time using this product, and I’m sure that if I had, I would have more advice for you. 
Feel free to point out things you discover. Perhaps I will add more to this document and update it online for 
you. 
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GeoGebra: Graphs and so much more 
 
GeoGebra (http://www.geogebra.org/download; I prefer the version called Classic 5, and that’s what has been 
used to prepare this file) is a free program that can be run as an applet in a browser window or as a separate 
application of its own on several different platforms. It is under continuous development by Markus 
Hohenwarter and a team of collaborators. As suggested by its name it combines geometry and algebra and will 
do some really useful things other than graphing.  
 
When you first open GeoGebra, you get 
a window like the one shown here. To 
graph a function, type it in the Input: 
field at the bottom. You enter 
expressions basically like you would in a 
calculator, with * for times, / for 
division, and ^ for powers. The numbers 
e and p are entered as e and pi, 
respectively, and the square root 
function is sqrt() with an argument 
inside the parentheses. Use parentheses 
carefully, just like you have to on a 
calculator. You can give it a name, like 
f (x), start with  
“y =,” or just type the expression you 
want to graph and a name will be 
assigned automatically. Once you’ve 
entered the expression, hit the enter key 
to see the graph. To graph another function along with the first, repeat the process.1 
 

Right-clicking is really important in this program. For instance, right-clicking on a graph 
and choosing Object Properties… will allow you to change the color and thickness of 
the graph, including its name and formula. If you choose Show Label, the default is just 
the name of the function (like f), but in Object Properties, you can change this to Name 
& Value to see its formula or Caption to see whatever caption you type in the field there. 
There are lots of options on the last few tabs, some of which are allow for quite powerful 
control of objects.  
 

There are traditional menus (File, Edit, etc.) 
at the top, but the buttons under those in the 
toolbar act as tool menus, too. Click on an 
arrow in the bottom right corner to see the 
choices you get. For graphing purposes, you will mainly want the first one with the white arrow which 
represents the Move tool and the last one with the axes that has the Move Graphics View, Zoom In, and 
Zoom Out tools. Holding down the Shift key also let you move the graphics view around. The escape key 
switches to the Move tool. 

	
1 For a list of the special functions that GeoGebra knows and how to enter them, see 
http://wiki.geogebra.org/en/Predefined_Functions_and_Operators.  
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To set up the graphing window, right-click in 
a blank area of the graph. You can turn the 
grid on or off here, and Graphics… lets you 
type in maximum and minimum values for 
each axis. The separate xAxis and yAxis tabs 
there are where you can have the tick marks in 

terms of p or  if needed and set the names 

of the axes to x and y (or whatever you need, including words). In 
addition to the choices in the drop-down menus, you can type in 
your own values. Save Settings will let you see the changes 
without closing the settings window to see if you’ve gotten the 
effect you want. Implicit functions involving polynomials in x and 
y can be graphed without solving for y first. You’ll learn what those are later, but if you want to see how cool 
they can be, try graphing x^2y + y^2x = 1 by typing it in the entry line. 
 
As you might expect, it is important to save your work. If you save the GeoGebra file, you can open it up later 
to tweak your graph. If you are using a school computer, save it to OneDrive or your own flash drive. You can 
also choose to show or hide individual curves by clicking on the little circles to the left of their equations. 
 
Getting a graph into a word processing document is simple. With the graph 
displayed as you like it on screen (you can resize the window, too), choose 
Graphics View to Clipboard in the Edit menu. Then paste it into your 
document. You can resize it by dragging a corner. That’s generally a good idea, 
because huge computer-generated graphs are rarely worth that much space. You 
can type around the graph, as I have done with the pictures in this document, by 
right-clicking on the picture, and choosing Tight, Square, or something else 
from the Text Wrapping menu (this is in Word, mind you). Then you can drag 
the graph wherever you’d like it to be. You may need to make the font size 
larger in the Options menu to make things easier to read; unfortunately, that also 
makes it larger everywhere. You’ll see what I mean if you try it.  

You can customize your graphs a lot, but remember that if a graph is hard to 
understand, it won’t help your communication, no matter how cool it may look to you. Also, the computer is 
just a bigger and possibly more colorful version of your graphing calculator, and the software is subject to 
some of the same limitations, like not always showing holes and possibly connecting dots it shouldn’t. You 
can restrict a function to a limited domain by using the Function command. Try typing  
Function[(x-1)^2-2,-1,3] to see how that works. 

2
p
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The Assignment 
Your assignment is to reproduce the things you see below, yourself. You may choose whatever colors you like 
on the graphs as long as they remain readable. Your goal is to have your work look as much like mine as 
possible; pay attention to detail. I have used MathType, so there will be some unavoidable differences if you 
use Word’s built-in equation editor. That’s not a problem. The assignment counts 50 points.  
 

Begin by opening a new Microsoft Word for Windows or Pages for Mac document and typing Geometry:, 
followed by the number of the first item and the words that follow. Then insert an equation, either in 
MathType or in the Word equation editor. (If you’re using MathType, close the MathType window, telling it 
to save your work, and go on to the next one. Do not copy and paste.) If you’re using a school computer, save 
your work to OneDrive or your own removable device (flash drive). Save early and often on any computer. 
You’ve been warned. You cannot use the online version of Word for this; it does not currently support any 
mathematical typesetting, and if you open your pretty document online, it will not show your math.  
 

Type everything that follows this paragraph, making it look as much like what I have typed as you can. Pay 
attention to the parenthetical advice that follows some of the expressions. (If you use the Microsoft equation 
editor, there will be some font and spacing differences. There is no penalty for that.) The one exception is that 
you may use one column rather than two. You must submit your work to me electronically, on Edmodo. Find 
the assignment and click Turn In to upload the file. If for some reason you must choose a word processor that 
is neither Word nor Pages, tell me what you used in the comment box where you upload your file. 
 
Geometry: 
 

1. Congruent segments 
   
 

2. Similar triangles 
   
 (That’s a “similar” tilde.) 
 

3. Angle measure 
 In ΔABC, we calculated that .  
 

4. Perpendicularity 
   
 (Look closely at the arrows. The first is a 

double arrow, and the second is a single one.) 
 

Algebra: 
 

5. Piecewise-defined function 

  
 

 

6. Rational expression 

   

 

7. Radical expression 
 Rational exponents can be used to rewrite 

as .  
 

8. Quadratic formula 

 If , then  

9. Complex fraction 

   

 

10. Binomial theorem 

  
 

Probability and Statistics: 
 

11. Probability of occurrence of either of two 
events 

   
 

12. Conditional probability 

   

 

13. Formula for standard deviation 

  where .  

 (Be careful where the subscripts and 
superscripts show up.) 
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Trigonometry: 
 

14. Pythagorean identity 
   
 

15. Sum and difference identity 

   
 (Yes, that’s a minus-or-plus, rather than a 

plus-or-minus, on the right-hand side. Note 
the equivalence symbol.)  

 

Calculus: 
 

16. Limit 

   
 

17. Derivative 

   
 

18. Integral 

  
 

 (That’s lowercase LN, the natural logarithm.)
 

 

Graphing: 

19.   and   

  
  
 (Be sure to type the equations for the 

functions along with the graphs here. Also 
pay attention to the details shown in the 
graphs. I will.) 

 
20. The graphs of and  nest 

together nicely. 
 (You enter these with parentheses around the 

x, just like on your calculator.) 
 

  
 

21.  
 

 (You type the absolute value into the graphing 
program as abs(stuff).)

 

   
 
22.   
 (It’s a semicircle, and it should look like one. 

You get the square root in GeoGebra as 
sqrt(stuff).) 
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